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MS Office Tutorial for beginners

To start with MS Office, you need to know how to use
its main programs, such as Word for writing, Excel
for making spreadsheets, PowerPoint for creating
presentations, and Outlook for managing your
email and schedules. This MS Office tutorial will help
you understand them easily. 

Download MS Office Tutorial PDF

Introduction to MS Office

Microsoft Office is a collection of programs meant
to facilitate productivity and complete routine
computer activities. We cover the following in this
MS Office tutorial:

Overview of MS Office
MS Word
MS Excel
MS PowerPoint
MS Access

Overview of MS Office

With MS Office, you can deal with data in databases
and spreadsheets, make presentations and posters,
and create and edit documents with text and
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images. Microsoft Office is a suite of specially
designed apps designed to automate manual
office tasks. 

The primary apps included in MS Office are MS
Word, MS Excel, MS PowerPoint, MS Access, OneNote,
MS Outlook, and Publisher. Enroll in our Artificial
Intelligence Course as it opens the door to various
trending job opportunities in top IT companies.

MS Office Interview Questions and
Answers

MS Word

Microsoft Word is a word processor that may be
used to create papers, letters, reports, and other
types of writing of professional caliber. With its
sophisticated tools, you may format and modify
your files and documents most effectively.

The Start Screen will show up the first time you
launch Word. 
You can select a template, start a new
document, and view the documents you’ve
recently changed from this menu. 
To open the Word interface, find and pick Blank
document from the Start Screen.
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Introduction A Tableau
Developer designs, develops,
and maintains dashboards
and visualizations using
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MS Office Tutorial

To find out more about the Word interface, click
the icons in the interactive below.

MS Office Tutorial 1

Working with the Word

Word has a Backstage View and the Ribbon and
Quick Access Toolbar, which include commands for
typical activities. All modern versions of Word have
these features.

Ribbon

Word replaces traditional menus with a tabbed
Ribbon interface. There are several tabs on the
Ribbon, which is located close to the top of the Word
window.

MS Office Tutorial 2

There are multiple groupings of related commands
on each tab. 

For example, you can format text in your document

Beginners VBA macros are
programs that automate
repetitive operations in
Microsoft…

https://www.softlogicsys.in/vba-macros-tutorial-for-beginners/


using the commands found in the Font group on the
Home page.

MS Office Tutorial 3

You can access additional options by clicking on
the little arrow located in the bottom-right corner of
certain groupings.

MS Office Tutorial 4

Showing and Hiding the Ribbon: You can hide the
“Ribbon” if you find that it occupies too much screen
real estate. To accomplish this, select the desired
option from the drop-down menu by clicking the
Ribbon Display Options arrow located in the
Ribbon’s upper-right corner: 

MS Office Tutorial 5

Ribbon auto-hide: This option shows your



document in full screen and obscures the
Ribbon entirely. Click the Expand Ribbon
command at the top of the screen to see the
Ribbon.
Show Tabs: When this option is selected, all
command groups are hidden but the tabs stay
visible. Just click a tab to bring up the Ribbon.
Show Tabs and Commands: Enables the
Ribbon to its fullest. Every command and tab
will be visible. When you launch Word for the
first time, this option is automatically selected. 

MS office Syllbus PDF

Quick Access Toolbar

No matter which tab is selected, you may access
frequently used commands with the Quick Access
Toolbar, which is situated directly above the Ribbon.
You can add more instructions based on your need,
but by default, it displays the Save, Undo, and Redo
commands.

Click the drop-down arrow located to the right
of the Quick Access Toolbar to add commands
to it.

MS Office Tutorial 6

From the menu, pick the command you wish to
add. 

https://www.softlogicsys.in/ms-office-course-syllabus/


MS Office Tutorial 7

The Quick Access Toolbar will have the
command added to it. 

MS Office Tutorial 8

Backstage View

You have many options when it comes to sharing,
printing, saving, and accessing files in Backstage
View. Click the File tab in the Ribbon to see
Backstage view.

MS Office Tutorial 9

To find out more about using Backstage View,
click the icons in the interactive below.



MS Office Tutorial 10

Try This!

1. Create a blank document in Word by opening
it.

2. Select “Show Tabs” under Ribbon Display
Options.

3. Spelling & Grammar, Quick Print, and New can
be added using the Customize Quick Access
Toolbar.

4. Type Shape into the Tell me bar and hit Enter.
5. Select a form from the menu and give it a

double-click anywhere within your document.
6. If the Ruler isn’t already visible, show it.
7. Zoom the document to 120%.
8. Select the Web Layout view for the document.
9. Reset the Document View to Print Layout and

the Ribbon Display Options back to Show Tabs
and Commands.

If you are a serious job seeker, explore our MEAN
stack training program designed for beginners
and all IT aspirants.

Ms Office Salary in Chenai

MS Excel

With the spreadsheet application Excel, you can
arrange, save, and analyze data. Although you
might believe that only specific individuals use Excel
to handle complex data, everyone can learn how to
utilize the program’s robust capabilities. 

Excel makes working with many types of data
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straightforward, whether you’re preparing an
invoice, maintaining a training log, or managing a
budget.

The Start Screen for Excel

The Excel Start Screen will show up the first time you
launch Excel. You can select a template, start a new
workbook, and view your most recent workbooks
from this screen.

To open the Excel interface, find the Blank
workbook and choose it from the Excel Start
Screen. 

MS Office Tutorial 11

The components of the Excel window

The ribbon and scroll bars in the Excel window are
common to most other Microsoft applications. The
formula bar, name box, and worksheet tabs are a
few characteristics that are unique to spreadsheets,
though.

To familiarize yourself with the components of
the Excel interface, click the buttons in the
interactive below. 



MS Office Tutorial 12

Utilizing the Excel Sheet

The Excel commands for typical tasks are located in
the Ribbon and Quick Access Toolbar. You have
many choices when it comes to sharing, printing,
saving, and opening files in the Backstage view. 

Ribbon

Excel replaces traditional menus with a tabbed
Ribbon structure. There are numerous tabs on the
Ribbon, each containing many command groups.
The most frequent tasks in Excel are completed
using these tabs.

There will be one or more groups on each tab.

MS Office Tutorial 13

You can click the arrows in certain groups to
view more possibilities.

MS Office Tutorial 14

To see more commands, choose a tab.



MS Office Tutorial 15

The Ribbon Display Options allow you to
customize how the Ribbon is shown.

MS Office Tutorial 16

Some applications, like Adobe Acrobat Reader, can
add more tabs to the Ribbon. We refer to these tabs
as add-ins. 

To modify the Ribbon Display Options: Although
the Ribbon is made to adapt to the job at hand, you
can choose to reduce its size if you find that it takes
up too much screen real estate. To see the drop-
down menu, click the Ribbon Display Options arrow
located in the Ribbon’s upper-right corner.

MS Office Tutorial 17

The Ribbon Display Options menu has three modes:

Auto-hide Ribbon: This option shows your
worksheet in full screen and conceals the
Ribbon entirely. Click the Expand Ribbon
command at the top of the screen to see the



Ribbon.

MS Office Tutorial 18

Show Tabs: When this option is selected, all
command groups are hidden but the tabs stay
visible. Just click a tab to bring up the Ribbon.

MS Office Tutorial 19

Show Tabs and Commands: Enables the
Ribbon to its fullest. Every command and tab
will be visible. When you launch Excel for the
first time, this option is automatically chosen.

The Quick Access Toolbar

No matter which tab is selected, you may access
frequently used commands with the Quick Access
Toolbar, which is situated directly above the Ribbon.
It comes with the Save, Undo, and Repeat
commands by default. Additional commands can
be added based on personal desire.

To add commands in the Quick Access Toolbar:

1. Click the Quick Access Toolbar’s drop-down
arrow on the right.

2. Choose the command from the drop-down
menu that you wish to add. Click More
Commands to view and select other
commands. 



MS Office Tutorial 20

3. The Quick Access Toolbar will have the
command added to it. 

MS Office Tutorial 21

Worksheet Views: Excel offers numerous viewing
options that alter the appearance of your workbook.
These views come in handy for many applications,
particularly if you intend to print the spreadsheet. 

Choose Normal view, Page Layout view, or Page
Break view from the commands located in the Excel
window’s bottom-right corner to alter the
worksheet’s view.

MS Office Tutorial 22

The default view for every Excel spreadsheet is



called Normal View. 
The Page Layout view shows you how your
worksheets will look on paper. In this view,
headers and footers are also addable. 

MS Office Project Ideas

Backstage View

You may save, open, print, and share your
workbooks using the backstage view, among other
choices. 

To access the Backstage View:

Click the File tab on the ribbon. A backstage
view will appear.

MS Office Tutorial 23

To find out more about using Backstage View,
click the icons in the interactive below. 

MS Office Tutorial 24



Try This

1. Open Excel.
2. Click New Spreadsheet to launch a new

spreadsheet.
3. Select “Show Tabs” under Ribbon Display

Options.
4. Click to add New, Quick Print, and Spelling

using the Customize Quick Access Toolbar.
5. Type the word color into the Tell Me bar.

Choose yellow by hovering over Fill Color. This
will cause the color yellow to fill a cell.

6. Select the Page Layout option to change the
worksheet view.

7. Return Show Tabs and Commands to the
Ribbon Display Options.

Explore a wide range of software training courses
at SLA and kickstart your promising career.

MS PowerPoint

Using the presentation software PowerPoint, you
can make dynamic slide shows. These
presentations can have a lot more content, such as
graphics, videos, animation, and narration. 

This part will walk you through using the Ribbon,
Quick Access Toolbar, and Backstage view in the
PowerPoint environment.

The PowerPoint interface

When you run PowerPoint for the first time, the Start
Screen will appear. You can select a template, start
a new presentation, and view your most recent
edits to presentations from this screen. 

To open the PowerPoint interface, find Blank
Presentation on the Start Screen and choose it.

https://www.softlogicsys.in/all%20courses/


MS Office Tutorial 25

Learn how to use the PowerPoint interface by
clicking the buttons in the interactive below:

MS Office Tutorial 26

Working with the PowerPoint

The controls to carry out typical activities in
PowerPoint are located in the Ribbon and Quick
Access Toolbar. You have many options when it
comes to sharing, printing, saving, and accessing
files in Backstage View.

The Ribbon

Traditional menus are replaced by a tabbed Ribbon
interface in PowerPoint. There are numerous tabs on
the ribbon, each containing many command
groups. 

For example, you can format text in your document
using the commands found in the Font group on the
Home page.



MS Office Tutorial 27

For even more alternatives, you can click on the
small arrow located in the bottom-right corner of
several groupings.

MS Office Tutorial 28

Showing and Hiding the Ribbon: Although the
Ribbon is meant to adapt to the job at hand, you
have the option to reduce its size if you think that it
is taking up too much screen real estate. 

To see the drop-down menu, click the Ribbon
Display Options arrow located in the Ribbon’s
upper-right corner.

MS Office Tutorial 29

Auto-hide Ribbon: This option shows your
worksheet in full screen and conceals the
Ribbon entirely. Click the Expand Ribbon
command at the top of the screen to see the
Ribbon.
Show Tabs: When this option is selected, all
command groups are hidden but the tabs stay



visible. Just click a tab to bring up the Ribbon.
Show Tabs and Commands: Enables the
Ribbon to its fullest. Every command and tab
will be visible. When PowerPoint is opened for
the first time, this option is automatically
chosen.

The Quick Access Toolbar

The Quick Access Toolbar, which is located just
above the Ribbon, allows you to access frequently
used commands regardless of the tab that is
selected.

It comes with the Save, Undo, Redo, and Start From
Beginning commands by default. 

Additional commands can be added based on
personal desire.

To add commands in the Quick Access Toolbar:

Click the Quick Access Toolbar’s drop-down
arrow on the right.

MS Office Tutorial 30

Choose the command from the drop-down
menu that you wish to add. Click More
Commands to view and select other
commands. 



MS Office Tutorial 31

The Quick Access Toolbar will have the
command added to it. 

MS Office Tutorial 32

The Ruler, guides, and gridlines

The Ruler, guidelines, and gridlines are just a few of
the tools that PowerPoint offers to assist with
content arrangement and organization in your
presentations. 

These tools make it easier to position elements on
your slides. To display or hide these tools, just click
the checkboxes in the Show group on the View tab.
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Backstage View

You have many options when it comes to saving,
opening, printing, and sharing your presentations
using Backstage View. 

Click the File tab in the Ribbon to see
Backstage view.

MS Office Tutorial 34

To find out more about using Backstage View,
click the icons in the interactive below.

MS Office Tutorial 35

Try This

1. Open PowerPoint and start with a blank slide
show.

2. Select “Show Tabs” under Ribbon Display
Options.

3. Select the Quick Access Toolbar and add New,
Quick Print, and Spelling by using the drop-



down arrow adjacent to it.
4. Type Shape into the Tell me bar and hit Enter.
5. Select a form from the menu, then double-click

on a slide location.
6. If the Ruler isn’t already visible, show it.
7. Enlarge the slide show to 120%.
8. Set the Ribbon Display Options back to

Commands and Tabs Shown.

Access unlimited placement assistance for all your
courses in our placement training institute.

MS office Online Training

MS Access

Access arranges commands using the Ribbon. You
should initially spend some time getting acquainted
with the Access interface, whether you’re new to the
program or have more expertise with previous
iterations.

To familiarize yourself with the Access interface,
click on the buttons in the interactive below.

MS Office Tutorial 36

Working in your Access

Access makes use of Backstage View as well as
features like the Ribbon and the Quick Access
Toolbar, which provide commands for carrying out

https://www.softlogicsys.in/placement-training-institute-in-chennai/
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frequent activities in Access. 

The Ribbon

Traditional menus are replaced by a tabbed Ribbon
layout in Access. There are numerous tabs on the
ribbon, each containing many command groups. 

For example, the Cut, Copy, and Paste commands
are located under the Clipboard group on the Home
tab.

MS Office Tutorial 37

You can access additional options by clicking on
the little arrow located in the bottom-right corner of
certain groupings.

MS Office Tutorial 38

How to maximize and reduce the Ribbon: The
Ribbon can be minimized if you find it to be taking
up too much screen real estate. Otherwise, it is
meant to adapt to your current job. 

To minimize the Ribbon, click the arrow located
in the lower-right corner of the Ribbon.



The ribbon will reduce in size. To make the
ribbon show again, click a tab. When it is not in
use, it will vanish once more.

MS Office Tutorial 40

To enlarge the ribbon, click on a tab and then
the pin symbol located in the lower-right
corner of the ribbon. There will always be a
ribbon. 

MS Office Tutorial 41

The Quick Access Toolbar

No matter which tab you are on, you may access
common tasks with the Quick Access Toolbar, which
is situated above the Ribbon. 

By default, it shows the commands for saving,



undoing, and rearranging. You can add more
commands to personalize it if you’d like.

MS Office Tutorial 42

Backstage View

You can save, open, and print your database using
a variety of choices while using the Backstage View.

To access the backstage view:

On the ribbon, select the File tab.

MS Office Tutorial 43

Selecting the File tab
The backstage perspective will show up.

Click on the icons in the interactive below
to learn more about utilizing Backstage
View.
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The Navigation Pane

Every item in your database is listed in the
navigation window. The objects are arranged by
kind into groups for better viewing. In the Navigation
pane, you can open, rename, and delete objects.

MS Office Tutorial 45

To minimize and maximize the navigation pane: 

The navigation pane can be minimized if you feel
that it takes up too much screen real estate. Its
purpose is to assist you in managing all of your
items.

Click on the double arrow located in the upper-
right corner of the navigation window to make
it smaller. 
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A minimization of the navigation window will
occur. To maximize it, click the double arrow
once again.

You can adjust the navigation pane to reduce its
size without completely minimizing it. All you have to
do is click and move the navigation pane’s right
edge. Release your mouse once the desired size has
been reached.

MS Office Tutorial 47

Arranging objects within the navigation window:

Objects are arranged by type by default, with forms
in one group, tables in another, and so on. However,
you can arrange the elements in the navigation
window in any way you see fit.

There are four ways to sort:



You can make a custom group for item sorting
using Custom. Just drag the desired objects
into the newly created group after sorting.
An item’s type is grouped by object type. This is
how things are configured by default.
Tables and Related Views group forms, queries,
and reports with the tables they refer to.
Objects are sorted by Created Date or Modified
Date according to when they were created or
last edited. 

To arrange objects in the Navigation pane:

Select the desired sort from the drop-down
menu by clicking the drop-down arrow located
to the right of All Access Objects. Choosing a
different sort option.

MS Office Tutorial 48

As a result of your selection, the items in the
Navigation pane will now be sorted.
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The navigation pane was sorted.

You can reduce the visibility of groupings of objects
you don’t want to view in the Navigation pane to
further alter its appearance. 

To access the group name, just click the double
arrow pointing upward. 

Click the downward double arrow to display a
group. Groups can be shown and hidden in the
Navigation pane.

MS Office Tutorial 50



Working on the Databases with the
Navigation Form

When a database is opened, some databases
come with an automatic navigation form that
opens. 

The purpose of navigation forms is to serve as
an intuitive substitute for the navigation pane. 
You can see and deal with standard forms,
queries, and reports using the tabs that they
contain. 
You can quickly and easily access your
commonly used objects when they are all in
one location.

Click the tab of an object to open it from a
navigation form. The item will show up inside the
form for navigation. You can interact with an object
as usual once it’s open. 

The navigation form in the example below features
tabs for orders, customers, and menu items near
the top-left corner. Clicking on any of these tabs will
access the corresponding object.

MS Office Tutorial 51

Your navigation form may not contain every form,
query, or report since navigation forms typically
only contain the objects that a normal user will
need to work with regularly. 



The database is now simpler to navigate as a result.
It also lessens the possibility that users would
inadvertently alter or remove important data from
the database by concealing tables and infrequently
used forms, queries, and reports.

It’s crucial to consult your database designer or
administrator before working with objects that
aren’t present in your navigation form because of
this. If you have permission, you can simply
maximize the navigation window and open the
objects from there.

Try This!

1. Access our practice database.
2. As you navigate through each tab, take note of

how the Ribbon’s options alter.
3. Reduce the ribbon’s size, then increase it once

more.
4. Make the navigation pane smaller to make it

more portable.
5. The items in the navigation pane can be

rearranged.

If you want career growth in IT, our mobile app
developer training will be helpful.

Advantages of Learning MS Office

Acquiring knowledge of Microsoft Office can provide
many benefits, such as:

Easy Collaboration: Employee collaboration
can be facilitated by MS Office tools, and team
members can access and store data from any
location thanks to cloud capability.
Security: Microsoft Office is built to guard
against viruses, and files are routinely checked
for disaster recovery.
Universal Fit: There are various versions of
Microsoft Office accessible for home users,
small enterprises, schools, and more. 
Efficiency: Employees with varying degrees of
experience can boost their productivity with
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Microsoft Office training. 
Adaptability: Having an MS Office certification
may make you a more adaptable worker and
enable you to accept online employment that
fits into your schedule. 
Data Analytics: With the use of Excel’s features,
you may combine worksheets into workbooks
to analyze and combine massive volumes of
data. 
Flexibility: Because MS Office applications are
available online, you can work more flexibly
and establish yourself as a leader. 

MS Office Training in OMR

Conclusion

The majority of businesses utilize Microsoft Office.
They utilize it for communications, sales, project
management, office administration, and business
accounting. It follows that most jobs will require you
to be proficient with it. We hope this MS Office
tutorial helps you understand the concepts easily.
Enroll for the hands-on practice in our MS Office
training in Chennai.
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